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The Center for Educational Performance and Information (CEPI) is pleased to release the Non-resident Student
Research Tool interactive data set. Creating specialized public data sets is part of CEPI’s mission to provide data and
reports to state and local policymakers as well as the citizens of the state to allow them to make informed policy

decisions and assess the return on their investment in the education system of Michigan.

This data set shows, at a point in time, the number of students who reside within one local education agency (LEA)
district’s boundaries, but attend school in another LEA district or Public School Academy (PSA), either through
Schools of Choice programs or other cooperative agreements. This data set can be created only by examining the

statewide individual student data that are maintained by CEPI via the Single Record Student Database (SRSD).

The release of this data set is a means to provide useful information to stakeholders and to satisfy multiple, frequent
data requests. The CEPI advisory committee designated a group of district volunteers to help the CEPI team define
characteristics of the data set. The Macomb Intermediate School District worked collaboratively with CEPI to
develop the documentation that accompanies this data set. CEPI would like to thank the advisory committee,
Macomb Intermediate School District, and pilot user volunteers. CEPI would appreciate feedback from users on the

data set, so please send e-mail responses to
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Chapter 1 - Pivot Tables & Project Overview
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Pivot Tables

When information is being tracked, there are often hundreds or thousands of records in
the source data. It is difficult, or maybe impossible, to look through the data and see the
trends. A better solution is to use a set of tools, like Pivot Table Reports and Charts
to help you summarize and analyze the trends from the data.

Pivot Tables and Charts help to extract meaning from large data sources. Three
benefits of using pivot table tools to organize data are:

e Summarizing large volumes of information
e Finding relationships within the data
e Charting the data to see the trends at a glance

The pivot table tools provide an interactive environment where information from the
source data can be re-organized in a variety of different ways. The source data remains
the same, but several different views of the source data can be created by dragging and
dropping fields within the report.

The Project

The Center for Educational Performance and Information (CEPI) collects data about
K-12 schools and students in Michigan. One of the projects CEPI has initiated tracks
students who receive educational services in a district other than their district of
residence. This project is called Non-resident Student Research Tool.

Some of the fields that are tracked in this project include:

e Operating District

(the district where the non-resident student attends school)
e Operating Building

(the building where the non-resident student attends school)
e Operating District Type

(ISD, LEA or PSA)
e Resident LEA

(the resident district of the student who attends elsewhere)
e Student Grade
e Student Count

(students who live in one district or county and attend school in another)




The data source for this project is very large. However, it is possible to use Pivot
Tables and Charts to summarize the project data and find meaningful trends and
relationships.

Some of the questions that can be answered using the pivot table with this data include
(questions courtesy of CEPI):

1. How many students are living in one ISD and attending school in another
ISD?
Does this vary by grade?
Is this a trend that has increased or decreased over the years?

2. How many students are living in one district and attending school in
another district?
Does this vary by grade?
Is this a trend that has increased or decreased over the years?

3. How many students live in a specific district and attend school in another
district?
What districts are they attending?
What district type are they attending (LEA, PSA or ISD)
What is the trend over the years?

4. How many non-resident students attend school in a specific district?
Where are they from?
What grade are they in?
What schools are they attending?
What is the trend over the years?

Next Steps
The remainder of this tutorial will guide you through the steps involved with:

e Getting started by creating a pivot table based on the CEPI data

e Analyzing the data (and answering the questions above) with the pivot table
e Formatting pivot tables

e Creating charts based on the pivot table numbers

Pivot Table Guide
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Chapter 2 - Getting Started

Creating the Pivot Table

The file from CEPI that contains the data for the Non-resident Student Research Tool
is housed in a data file called 2007NonResident.cub.

The state provides the file in zipped format. You will need to unzip the
2007NonResident.zip file and save 2007NonResident.cub prior to
proceeding with the steps below.

Once the file is unzipped and 2007NonResident.cub is saved the following steps will
create the Pivot Table interface (courtesy of CEPI):

1.

2.

3.

Open a new Excel workbook.

From the Data menu, select Import External Data—>New Database Query...

mat Tools | Data | FlashPaper Window Help  Adobe PDF

5 1 J 28 sort.. | 2| |l 4B 100% @)! : arial
Filter »
Subtotals. ..
I validation. .. H | | a | K | 5
! Text to Columns... + 1 T 1

:,._3] PivotTable and PivotChart Report. ..

| Import External pata V| 3 tmportDate...
List ¥ |G| Mew Web Query...
XML * "9 Mew Database Query...
Refresh Data ¥

(%

In the Choose Data Source dialog box, select the OLAP Cubes tab and select
<New Data Source>. Press OK.

Choose Data Source

0L Cutes | |
<Mew Data Saources
MHon-RezidentStudentE nrollment QEEHDQ

Erowse... |

D atabazes ] [lueries




5.

6.

7.

8.

The Create New Data Source dialog box will appear asking for 2 pieces of
information — the name of the data source and the OLAP provider. Any name
can be used, but it makes sense to use a name consistent with the filename such
as 2007NonResident

Create New Data Source

Ywhat name do pou want to give your data zource?

1. |2007MonFesident

Select an OLAP provider for the databaze pou want to access:

Opposite step 2 in the dialog box select the OLAP provider. The correct provider
to choose is Microsoft OLE DB Provider for OLAP Services 8.0.

Create New Data Source

“What name do you want to give vour data source?
1. |2007¥MonResident

Select an OLAP provider for the databaze pou want to access:

R M icrosoft OLE DB Provider For DLAP Services 8.0

Click Connect and enter any information requested by the provider:

Click the Connect... button opposite step 3 in the dialog box.

mactand enter any information requested by the provider:

=

The Multidimensional Connection dialog box will appear. Select the Cube File
option.

® Multidimensional Connection

This wizard will help you connect to a multidimensional data source,

Choose the location of the multidimensional data source that you
want to use,

(" Analysis server | {* Cube file \

File: |

Opposite the File: option in the dialog box click the button.
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9. The Open dialog box will appear. Browse to the location where you have saved

the 2007NonResident.cub file from the state. Select the file and click Open.

Open

_J

Recent

F‘ =
E
Desltop

My Documents

My Computer

My Network
Places

?X

Look in: l I Pivat Table

~| o~ B E-

|CS1Excel Dashboard

==/ 200 MonResident. cub

File name: 2007 MonResident .cub j

Files of type: [Cube Files {* cub) -l

FE

This wizard wil help you connect to a multidimensional data source,

Choose the location of the multidimensional data source that you
want to use.

" Analysis server o Cube file

File: |C:'\Documents and Settingskfandale'De

| | Einish | | Cancel |
I




11.Click OK in the Create New Data Source dialog box.

Create New Data Source

“What name do you want ta give your data source?
1. |2|:||:|?N onFezident

Select an OLAP provider for the databagze vou want to access:

2 |I'-1i|:r|:|su:|ft OLE DB Provider for OLAP Services 8.0 ﬂ

Click Connect and enter any information requested by the provider:

AW Cube

Select the Cube that containg the data you want:

4 | QCwWCube j

I Save my uzer 1D and password in the data source definition
g

12.Click OK in the Choose Data Source dialog box.

Cancel |

Choose Data Source

Datal:-ases] Queries  OLAP Cubes l

<Mew Data Source:

2007 M onBesident

Man-ReszidentStudentE nrallment
Browse. ..

13. Click Finish in the Pivot Table and Pivot Chart Wizard dialog box.

PivotTable and PivotChart Wizard - Step 3 of 3

) Mew worksheet
(%) Existing worksheet

Cancel

Where do you want to put the PivotTable report?

T |

Click Finish to create your PivotTable report.

[ Layout... ][ Options. .. ] [ Cancel ]

=

14.The blank pivot table is now created in Excel, and it is ready to be used to

summarize and analyze the data.
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Chapter 3 - Analyzing Data

Pivot Table Layout

The pivot table is an interactive worksheet table that can be modified by dragging and
dropping fields from the field list into various locations on the table.

The blank pivot table framework looks something like the picture below with 3 related

components:

e Pivot Table Grid
e Pivot Table Field List
« Pivot Table Tools

B Microsoft Excel - Book2

EBX

@] File Edit WView Insert Format Tools Data FlashPaper Window Help Adobe PDF Typeagueston forhelp =2 @ X
NEE RSN T E BB S0 R g 2@l 1> B
iy Mgl
A3 b S
1 A | B [ ¢ _ |_ [ G H I J K L M B
2 e ;
i 5 ———— BivotTable v | 73 [illl | =2 *= | ¥ IEI"_I
4] O _ -]
% 3 ST A ekl bk T X1 Pivot Table Tools
7 = Drag items to the PivotTable report
E ED - [Z] Collection ~ - I ]
9 gﬁ ] ECOIOrder
=] o H B
% :-I D ro p D ata I te I | l b} e re [+ EOperatingBuildingName :U
F ;_: (7] EOperaﬁnngsh'lch‘lame g
13| ? =] EOperaﬁngDish'icﬁ“-lumber =
E I =] EOperaﬁnngsmctT\-'pe 9 ;1
| 15 | : &3 EOperatingISDCDde E
16 © £ EOperaﬁngISDName o
17 (ﬁ ez
ERl - - - [] ResidentlsDCade I -
ET) Pivot Table Grid - [=]ResidentISDName “[ =
] £
20 : £ 4
% Add To |R0w Area vl i
W 4 » M Sheetl Sheetz { Sheet3 / |« >
Ready

The Pivot Table Grid has 4 locations where fields can be dropped. There is the:

¢ Row area which shows the items in the field as row labels

e Column area which shows the items in the field as column labels

e Page area which shows the data for one item at a time in the table
Data area to summarize the values in the body of the table

The Row, Column and Page fields usually contain text values. The Data field typically
contains numeric data used for summarizing.

With the Non-resident Student Research Tool data source, the most

likely value for the Data area will be Sum of Student Count.




Using the Pivot Table

The best way to make use of the Pivot Table is to begin with a question in mind, then
set up the Page, Row, Column and Data fields to answer the question.

Question 1
1. How many students are living in one ISD and attending school in another
ISD?
e Does this vary by grade?
e Isthis atrend that has increased or decreased over the years?

In our examples the 4 questions posed earlier will be used.

1. There are a variety of different ways that this question can be answered using
the pivot table.

2. The first step might be to drag the OperatinglISDName to the Row area on the
Pivot Table Grid to get something that looks like this:

3 Microsoft Excel - Book2

i#] Fle Edit View Insert Format Tools Data FlashPaper \iindow Help  Adobe PDF
NS EHR GRS E@B F o2 s 8] R 100% "@!iﬁﬂﬂ‘ 10 o|B 1]

o sl

F13 - A

Drop Column Fields Here
hlegan Area Educational Service Agency
Ipena-Montmorency-Alcona ESD PivotTable Field List - x
i Drag items to the PivotTable repart

& [S] Collection A
Drop Data ltems Here Ao
3] EOperaﬁngEuﬂdingName
harlevoix-Emmet ISD I .| [ [5] OperatingDistrictiame
heb-Otsego-Presque Isle ESD [l [5] GperatingDistrictiumber

lare-Gladwin RESD
linton County RESA
opper Country I1SD

2] EODETEUHQDISME(T\-‘DE B
[} EODEraﬁnngDCﬂdE

[ [5] OperatingISDHame

[} ERES\dEnUSDCDdE

[ [ZResidentISDName M
< | >

E [

bogebic-Ontanagon ISD [Ronares v
Gratiot-lsabella RESD
illsdale I1SD

uron 1SD

If you click outside of the Pivot Table Grid, the Field List will disappear.
To get the Field List back simply click inside the Grid again.
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3. The ResidentISDName could be pulled to the Column area in this example, but

that is going to create a very wide table that may be difficult to analyze. Instead,
the ResidentISDName can be pulled to the Page area to see the results for one
ISD at a time.

B Microsoft Excel - Book2

@] file Edit View Insert Format Tools Dats  FlashPaper Window Help  Adobe PDF
NESHRAAGSRD T 6B S0 oo0 F -8 EL S 0 - @l 210 2

ol

13 i i

esident!SDMame

[Al =]

it
£
s

1
2

) TS PR ) O T

4

| 14 |Cheh-Otsego-Presque Isle ESD
| 16 |Clare-Gladwin RESD
| 16 |Clinton County RESA
| 17 [Copper Country ISD
| 18 | Delta-Schoalcraft 1SD
9 |Dickinson-Iron ISD

Gratict-lsabella RESD

[ [Z] Residentl EANUmber

[+ [Z] studentResidency
~[3]5um Of FTESum
Sum Of StudentCount

.11 E StudentGradeCrSetting

- Drop Column Fields Here
| 5 |Allegan Area Educational Service Agency
| 6 |Alpena-Montmarency-Alcona ESD PivotTable Field List - X
7 |Barry ISD ; :
e Drag items to the PivotTable report
| & |Bay-Arenac ISD
| 3 |Berrien ISD [ [] OperatingISDiame
10 |Branch ISD :
bt B-[=|ResidentISDCode
[11]c.00R ISD Drop Data ltems Here e e
12| Calhoun ISD Ll

13| Charlevoix-Emmet ISD [ 1 5 [2| Resicenti=ANeme

el

20 |Eastern Upper Peninsula ISD

21 |Eaton |1SD £ | [
22 |Genesee I1SD :

23 |Gogebic-Ontonagon 1SD | AddTo |Rm\ Area hd

4. Finally, the Sum of Student Count can be pulled into the Data area.

3 Microsoft Excel - Book2

i8] Fle Edit View Insert Format Tools Data  FlashPaper Window Help  Adobe POF
N EHR GG T SR T 98 - E s s @ e

meliaol
A3 -

£ Sum Of StudentCount

A 555757 e o 5 o | ] = 1
1 |ResidentlSDName lan [+
2
3 [Sum OF StudentCount Bt
4 |OperatingISDName |4 ¥ctal
| 5 |Allegan Area Educational Senice Agency] 11685
| 6 |Alpena-Montmarency-Alcona ESD 2370] PivotTable Field List - x
i g:mﬁﬁa: &5 =y Dreg fems to tre ProtTable report
| 9 |Berrien ISD 29171 & [S|OperatinglsDlame &
[0 Branch 150 5922 - [S]ResidentIsDCode
11|C.O0R ISD 1696 i
42 |Calhoun ISD 26594 5-[Z] ResideattoDliame
| 13 | Charlevoix-Emmet ISD 9591 £l: [ Resident =AName
| 14 |Cheb-Otsego-Presque Isle ESD 4014 ) [F]Residentl 2atumber
| 15 |Clare-Gladwin RESD 4578 # [E]studentGradetrsetting
| 16 |Clinten County RESA 3678 ) [S]sdenmesdency
17 | Copper Country ISD 5442 ¥
18| Defta-Schoolcraft 10 3043 fplis S CEETERn
[ 18 |Dickinson-ron 18D 4653 Gilusotatadent Cou N
20 |Eastern Upper Peninsula ISD 6179 2
21 |Eaton ISD 6263 4 | &
| 22 |Genesee 1SD 59162 IData e 3
| 23 | Gogebic-Ontonagon ISD 1252 L
| 24 | Gratiot-lsabella RESD 15247]
| 25 |Hillsdale ISD

This data displays the number of students over 5 years (Fall of 2002
through 2007) within each Operating ISD who lived in one district (or ISD)

and attended school in another.




5. To further analyze this data it will be helpful to select a specific
ResidentISDName from the page area. This can be accomplished by selecting
the drop-down arrow next to the word All, then clicking the Plus Sign next to the
word All in the dialog box.

- E— = = | = | -

|
ResidentlSDName lan T+=1

Sum Of StudentCount

OperatinglSDMName [=
Allegan Area Educational Service Agency
Alpena-Maontmorency-Alcona ESD

MY 1

4|m|r_n.lb-t_ur\_-._.

6. A list of ResidentiallSDNames will be displayed. Select one, and then click OK.

- Pivo

]5@_] Ele Edit Vew Insert Format Tools Data FlashPaper Window Help Adobe

N EE B SSRGS S B8 S
i Arial -0 -|B L U|E==HE S
Ab - F OperatinglSDName
A [ B | C
g1
4”2 [ResidentiSDName FTE
: =
—1 Kent ISD A
4 |Sum Of StudentCount Lapeer 15D 3
_ LleiilEn B © Lenawee ISD [able ~
6 |Allegan Area Educational Serice Agency L ewis Cass 150
7 |Alpena-Montmarency-Alcona ESD
8 |Barry ISD 0
9 |Bay-Arenac ISD it E
10 (Berrien ISD Marguette-Alger RESA =
11 [Branch ISD - Clikdocoo ="|° I, =
12|C.0O.0R ISD
13 |Calhoun ISD [ Select multile items
14 [Charlevoix-Emmet ISD OK Cancel
15 [Cheb-Otsego-Presque Isle ESD
16 |Clare-Gladwin RESD 4578
17 [Clinton County RESA 3678
18 [Copper Country ISD 5442
Bl 19 |Delta-Schooleraft ISD 3948

This data displays the number of students over 5 years (Fall of 2002
through 2007) who were residents of a Macomb ISD district and
attended school outside of that district (or outside of the ISD).

7. At this point there are fields in the page and row areas of the table. To add a
field to the column area it would be dragged to the area outlined in red below
(above the word Total).

A B
1 [ResidentlSDMName Macomb 1SD |+
2
3 [ Sum Of StudentCount
4 |OperatinglSDMame - |lota
5 |Allegan Area Educational Service Agency 1
6 |Barry ISD 1
7 |Calhoun ISD 34
8 |Geneses 13D 1
9 |Gratiot-lzabella RESD 2
A0 LA Adala 1S 415

Pivot Table Guide

3



Pivot Table Guide

~

10.

To see if Grade is a factor in the choice to attend school outside of the district,
the StudentGradeorSetting field can be dragged into the Column area.

[BlClD[E|F[G[H] I |J[K[L|M|N[O|P|Q|R[ESYy I |
1 |Resident|SDName [W{=Jomb 15D =
2 1

3 [Sum Of StudentCount i

4 |OperatinglSDName

3 |Allegan Area Educational Service Agency

5 |Barry ISD 1 1
7_|Calhoun ISD 3 3 2 1 2 1 3 1 1 3 14 34
3 |Geneses ISD 1 1 1 1 1 4 1 1 "
3 |Gratiot-lsabella RESD 1 1 2
0 |Hillsdale 1SD 1 2 4 1 3 1 12
1 |Ingham ISD 1 1
2 |Kalamazoo R.E.S.A 1 13 14
3 |Kent ISD 2 1 1 1 2 1 &
4 |Lapeer ISD 13 6 4 4 3 3 1 4 4 9 10 Tn 3 4 3 89
5 |Livingston ESA 1 1
6 |Macomb ISD 50/ 5050 4852 4576|4211 4023 3722 3636| 3351| 3128 3689 3737 5193 5683 2875 6635 2132 1829 68574
7 |Mecosta-Osceola ISD 1 1 2
8 |Menominee I1SD 1 1
9 |Midland County ESA 1 1 2
10 |Monroe 15D 1 1
11 |Oakland Schools 4181 137 124) 106 95 87 94) 80| 77 100 219 150 297 546 21 506 3 2802
12 |Sanilac I1SD 1 1 2
13 |5t Clair County RESA 3 31 47 44 36| 41 34 35 30 30/ 29 28 44 48 11 1 2 494
4 |Washtenaw I1SD 2 1 1 1 1 1 1 1 1] 14
15 |Wayne RESA 96 94 76| 78| 73 59 51 40| 34| 92 63 7 72 25 1 919 1850
16 | Grand Total 57 5349 5140 4829 4439 4239 3907 3821 3511 3278 3841 4066 5475 6316 3465 6661 3560 1840 T3M6

Grade Level information:

00 — Kindergarten

01-12 — Grade 1 through grade 12
14 — Special education setting

20 — Adult education

30 — Early Childhood/Early On

To see the trend over the years (between Fall 2002 and Fall 2007) drag the
StudentGradeorSetting out of the Column area back to the Field List.

Drag the Collection field to the Column area.
A | B | ¢ | o | E | F | & | H ] J]

1 [ResidentlSDMName |Macomh 1SD m |

2

3 [Sum Of StudentCount (Collection ||

i Opesingsilams | TS AT TN TS A PR
| 5 |Allegan Area Educational Service Agency
| 6 |Barry ISD 1 1
| 7 |Calhoun ISD 8 7 7 5 5 2 34
| 8 |Genesee ISD 5 3 3 "
| 9 |Gratiot-lsabella RESD 1 1 2
| 10 [Hillsdale I1SD 5 7 12
| 11 [Ingham ISD 1 1
| 12 |Kalamazoo R.E.S.A 1 13 14
| 13 [Kent ISD 1 1 6 i
| 14 |Lapeer ISD 12 8 9 10 22 28 a9
| 15 [Livingston ESA 1 1
| 16 [Macomb ISD 8270 9348 10911 11778 13158 15108 66574
| 17 |Mecosta-Osceola ISD 2 2
| 18 [Menominee 1SD 1 1
| 19 [Midland County ESA 2 2
| 20 |Monroe ISD 1 1
| 21 |Oakland Schools 394 430 414 423 546 595 2602
| 22 |Sanilac 1SD 1 1 2
| 23 |St. Clair County RESA 46 a2 76 a0 112 128 494
| 24 [Washtenaw ISD 7 1 1 3 2 14
25 |Wayne RESA 64 168 186 356 49 585 1850
26 |Grand Tatal 8803 10019 11610 12663 14350 16471 73916




Question 2
2. How many students are living in one district and attending school in
another district?
e What district type are they attending (LEA, PSA or ISD)
e Does this vary by grade?
» Isthis a trend that has increased or decreased over the years?

For this question, districts from just one ISD will be analyzed at one time. To do this,
the ResidentISDName will be kept in the Page area. The SumofStudentCount will
also be kept in the Data area.

1. Drag OperatinglISDName from the Row area back to the Field List.

2. Drag ResidentLEAName from the Field List into the Row area.

A B c
1 [ResidentlSDMName Macomb ISD |-
2
j%
41]ResidentLEAName = |[otal
| 5fJAnchar Bay Schoal District 1958
| GJJArmada Area Schools 418
| T{|Center Line Public Schools 2183
)} Chippewa Valley Schools 5256
| 3} Clintondale Cammunity Schools 4401
| 10} East Detroit Public Schools 1037
14| Fitzgerald Public Schools 2013
14| Fraser Public Schools 2260
13} Lake Shore Public Schools (Macomb) 3049
| 14| Lakeview Public Schools (Macomb) 1727
19 L'Anse Creuse Public Schools 4107
18} Macomb ISD g
1Mt Clermens Community School District 4800
E]New Haven Community Schools 2573
19 Richmond Community Schools 2050
| 20} Romeo Community Schools 1138
21| Roseville Community Schools 6354
4l South Lake Schools 2037
3| Utica Community Schools 7144
 241Van Dyke Public Schools 3950
281 Warren Consolidated Schools G611
281 Warren Woods Public Schools 2181
21 73916
28
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3. To see the OperatingDistrictType that these students are attending, the
OperatingDistrictType can be pulled into the Row area (as a second Row area
field) to give results displayed like this:

provide results displayed like this:

A B c | D|E|

1 |ResidentlSDMName Macomb I1SD

2

3 |Sum Of StudentCount

4 |ResidentLEAName OperatingDistrictType otal
| 5 |Anchor Bay School District ntermediate School Dist /Eductnl. Service Agency 462
| 6 | _ocal Education Agency (District) 1033

7 “ublic School Academy (District] 493

8 [Anchor Bay School District Total 1988
| 9 |Armada Area Schools ntermediate School Dist /Eductnl. Service Agency 96
| 10 | _ocal Education Agency (District) 274
11 “ublic School Academy (District] 48
12 |Armada Area Schools Total 418
| 13 |Center Line Public Schools ntermediate Schoal Dist /Eductnl. Serice Agency 294
14 | _ocal Education Agency (District) 1635
15 “ublic School Academy (District) 254
16 |Center Line Public Schools Total 2183
17 |Chippewa Valley Schools ntermediate School Dist./Eductnl. Serice Agency 1154
| 18 | _ocal Education Agency (District) 3N
19 “ublic School Academy (District] 981
20 [Chippewa Valley Schools Total 5256
| 21 |Clintondale Community Schools ntermediate School Dist./Eductnl. Service Agency 291
| 22 | _ocal Education Agency (District) 3490
23 “ublic School Academy (District) 620
24 |Clintondale Community Schools Total 4401
| 25 |East Detroit Public Schoals ntermediate Schoaol Dist./Eductnl. Service Agency 636
26 _ocal Education Aaency (District) 5041

An alternative is to drag the OperatingDistrictType into the Column area to

A B | c | | E | F

1 |ResidentlSDName [acomb 1SD =]

2

3 |Sum Of StudentCount peratingDistrictType

4 |ResidentLEAName ntermediate School Dist /Educt Local Education Agency (District
| 5 |Anchaor Bay School District
| 6 |Armada Area Schools 96 274 48 418
| 7 |Center Line Public Schools 294 1635 254 2183
| 8 |Chippewa Valley Schaols 1154 3121 951 5256
| 9 |Clintondale Community Schools 2N 3490 620 4401
| 10 |East Detrait Public Schools 636 5041 1360 7037
| 11 |Fitzgerald Public Schools 304 1440 269 2013
| 12 |Fraser Public Schools 310 1724 226 2260
| 13 |Lake Share Public Schoals (Macomb) 332 2536 181 3049
| 14 |Lakeview Public Schools (Macomb) 219 1326 182 1727
| 15 |L'Anse Creuse Public Schools 835 2563 T4 4107
| 16 |Macomb ISD 2 3 3 8
| 17 |Mt. Clemens Community School District 412 3359 1129 4300
| 18 |New Haven Community Schools 208 1278 1087 2573
| 19 |Richmaond Community Schools 162 1275 613 2050
| 20 |Romeo Community Schools 306 733 100 1139
| 21 |Roseville Community Schools 4 4667 1476 6534
| 22 |South Lake Schools 220 1718 99 2037
| 23 |Utica Community Schools 1626 4105 1413 7144
| 24 Van Dyke Public Schools 499 2910 541 3950
| 25 |\Warren Caonsolidated Schools 1152 3759 1700 6611
26 Warren Woods Public Schools 21 1561 409 2181
27 |Grand Total 10472 49556 13888 73916
28

This data displays the number of students over 5 years (Fall of 2002
through 2007) who were residents of the listed LEA within Macomb county
but attended school outside of that district (or outside of the ISD).




To see if Grade is a factor in the choice to attend school outside of the district,

the Operating District Type can be dragged back to the field list and the

StudentGradeorSetting field can be dragged into the Column area.

A

[Bl|c|D[E[F[G[H]

ITJJdJkKILImM]INJOo[P]Q@[R][S]

ResidentlSDName

[{=Fomb 1SD

Sum Of StudentCount

ResidentLEAName

1

2

3

4
| 5 |Anchor Bay School District
| 6 |Armada Area Schoals
| 7 |
| 8 |
| 9 |

0

22 18 14 12 13 10 11 100 11 130 21 25 1020 46 T2 4 14 418

Center Line Public Schools 4 76/ 83 99 90 83 75 70 72| 72 136 174 332 372 110 118 156 56 2183
Chippewa Valley Schools 7| 435 373 329 306 291 262 205 202 191 182 177 260 414) 451 743 201 227 5256
Clintondale Community Schools 406 341 339) 308 303 291 307 280 245 288 243 350 319 86 182 &3 60 4401

| 10 |East Detroit Public Schools 3] 590 561 517 496 502 438 430 408 385 534 510 409 405 294 384 84 87 7037
| 11 |Fitzgerald Public Schools 8 128/ 120 112 98 82 66/ 78 67 68 128 198 2400 222 109 173 67 49 2013
| 12 |Fraser Public Schools 1109 113 100 104 95 88 102 87 92 127 125 234) 364 163 224 100 42 2260
| 13 |Lake Shore Public Schools (Macomby) 1) 108 178 178 168 172 174 172 193] 216 167 175 413 395 62 209 31 36 3049
| 14 |Lakeview Public Schools (Macomb) 2/ 95 75 78 B0 T4 71 60| 53 57 127 115 221 260 91 156 6O 43 1727
| 15 |L'Anse Creuse Public Schools 356 317 288 238 237 210 182 154) 156 225 229 280 271 166 536 123 136 4107
| 16 |Macomb ISD 2 1 1 3 1 8
| 17 |Mt. Clemens Community Schoal District 375 400 389 360 344 324 321 286 241 285 244 241 262 302 265 216 45 4900
| 18 |New Haven Community Schools 283 275 277 234 210 197 146 130 118 135 113 147 113] 25 107 23 40 2573
| 19 |Richmaond Community Schaols 80) 123 120 122 117 107 97 92 70 112 151 352 331 2§ 106 16 26 2050
| 20 |Romea Community Schools 1 85 60| 61 &4 62 52) &1 B3 B3 53| 62 67T 126) 19 205 23 37 1139
| 21 |Roseville Community Schools 3] 592 561 5200 400 452 397 383 346 322 419 372 348 427 361 5120 230 149 6554
| 22 |South Lake Schools 72 86/ 88 94 92 70| 95 91 98 136 158 241 268 157 189 62 37 2037
| 23 |Utica Community Schools 7| 377 414) 402 373 351 335 323 258 249 160 204, 325 502 380 983 1203 328 7144
| 24 |Van Dyke Public Schools 3] 305 284 258 214 206 197 218 228 166 240 257 404 356 201 287 77 49 3950
| 25 |Warren Consolidated Schools 5 530 465 414 349 334 335 353 285 279 284 302 253 369 334 807 727 186 6611
26 |Warren Woods Public Schools 9 M7 1356 118 125 117 116 116 103 100 105 150 245 323 24 166 24 8B 2181
27 |Grand Tatal 575349 5140 4829 4439 4239 3807 3821 3511 3276 3941 4066 5476 6318 3465 G661 3580 1540 73916

a0

To see only specific column headings, click on the list arrow opposite
StudentGradeorSetting. Uncheck those grades you would prefer to leave out

of the table.

B [c|p|lEJF ]G
|Macomb 1SD [+]
[StudentGradeOrSett(+ |
- 03 04
pB 124 1
4 12 i
9 90 ¢
by 306 2
ols 9 308 3
7486 AC
2 988 ¢
0 104 ¢
Jdacomb) Fg 168 13
comb) 7880 3
5 g 238 2
wol District 9/ 360 3¢
ols 7 234 2
Is | b0/ 122 1
[ OK ] [ Cancel ! 54 ;
3 PO 490 4%
T [2ls] 5 94
ToO377 414 402 373 3¢
3l ansl 2a4l 2830 2140 or
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You will then see the numbers and totals for just those grades you are interested
in including with the results.

A [ B [ ¢c [DJEJFIe[HIIT[J[K][L[M]N] o | P

1 [ResidentlSDMName [Macomb 1]~ |

2

3 |Sum Of StudentCount tudentGral ~

4 |ResidentLEAName [=kbo 01 02 03 04 05 06 07 03 09 10 11 12 [Grand Total
| 5 |Anchor Bay School District L T T L
| 6 |Armada Area Schoaols 22 18 14 12 13 10 11 10 11 13 21 25 102 282
| 7 |Center Line Public Schools 76 88 9% 90 83 Y5 70 72 72 136 174 332 372 1739
| 8 [Chippewa Valley Schools 435 3730 329 306 291 262 205 202 191 182 177 260 414 3627
| 9 |Clintandale Community Schools 406 341 339 308 303 291 307 280 245 288 243 350 319 4020
| 10 |East Detroit Public Schools 590 561 517 496 502 438 430 408 385 534 510 409 405 6185
| 11 |Fitzgerald Public Schools 128 1200 112) 93| 82 66 78 67 68 128 198 2400 222 1607
| 12 |Fraser Public Schools 109 113 1000 104) 95 8B 102 &7 92 127 125 234 364 1740
| 13 [Lake Shore Public Schools (Macomb) 109 178 178 168 172) 174 172 193 216 167 175 413 395 2710
| 14 |Lakeview Public Schoaols (Macomb) 95 75 78 80 V4 T1 60 53 57 127 115 221 260 1366
| 15 |L'Anse Creuse Public Schools 356 317 288 238 237 2100 182 154 156 22§ 229 280 271 3146
| 16 |Macomb ISD 1 1 3 5
| 17 |t Clemens Community School District 375 4000 389 3600 344 324 321 286 241 285 244 241 262 4072
| 18 |New Haven Community Schaols 283 275 277 234 210 197 146 130 118 135 113 147 113 2378
| 19 |Richmand Community Schools 80 123 1200 122 117 107 97 92 70| 112 151 352 3: 1874
| 20 |Romeo Community Schools ik 60 61 54 62 52 51 63 53 58 62 67 126 G54
| 21 |Roseville Community Schools 592 561 520 490 452 397 383 346 322 M9 372 348 427 5629
| 22 |South Lake Schools 72 86 83 94 92 FO 98 91 98 136 158 241 268 1592
| 23 |Utica Community Schaols 37T 414 4020 373 351 335 323 256 249 160 204 325 502 4273
| 24 [Van Dyke Public Schools 308 284 258 214 206 197 218 228 166 240 257 404 356 3333
| 25 |Warren Consolidated Schools 5300 465 414 349 334 335 353 285 279 284 3020 253 369 4552
26 |Warren Woods Public Schools 117 135 118 125 117 116 116 103 100 105 150 245 323 1870
27 | Grand Total 5349 5140 4829 4439 4239 3907 3821 3511 327§ 3941 4066 5475 6318 58313
28

To see the trend over the years (between Fall 2002 and Fall 2007) drag the
StudentGradeorSetting out of the Column area back to the Field List. Drag
the Collection field to the Column area.

L | = o= e = ! L= LA LI
1 |ResidentlSDMName [Macor]~ BD |
2
3 |Sum Of StudentCount
4 |ResidentLEAName

| 5 |Anchor Bay Schoal District i : -

| 6 |Armada Area Schools 62 62 64 43 61 g6 415

| 7 |Center Line Public Schoals 247 253 457 arz2 425 429 2183

| 8 |Chippewa Valley Schools 660 744 823 889 921 1219 5256

' 9 |Clintendale Community Schoals 443 624 739 742 873 930 4401

| 10 |[East Detrait Public Schoals 670 885 1008 1215 1503 1756 7037

| 11 |Fitzgerald Public Schoals 177 208 314 378 453 483 2013

| 12 |Fraser Public Schools 330 333 338 416 382 461 2260

| 13 |Lake Share Public Schools (Macemb) 471 503 827 4381 498 569 3049

| 14 |Lakeview Public Schoals {Macomb) 243 264 287 284 308 kLS| 1727

| 15 |L'’Anse Creuse Public Schools 507 573 630 716 738 893 4107

| 16 [Macomb I1SD 8 g

|17 |Mt. Clemens Community School District 387 628 GBE 967 1047 1205 4900

| 18 |New Haven Community Schoaols 291 324 395 410 47 652 2573

| 19 |Richmond Community Schoals 241 229 340 373 433 434 2050

| 20 |[Romeo Community Schoaols 152 141 1581 158 185 351 1138

' 21 |Roseville Community Schools 915 974 1081 1153 1317 1444 6534

| 22 |South Lake Schools 348 346 309 292 355 387 2037

| 23 |Utica Community Schoaols 1036 1067 1143 1227 1369 1302 7144

' 24 |Van Dyke Public Schools 398 457 590 637 N 1027 3930

| 25 |Warren Consolidated Schools 7 859 1045 1098 1372 1519 6611
26 |Warren Woods Public Schools 219 266 347 386 459 494 2181
27 | Grand Total 8803 10019 11610 12663 14350 16471 73916

| 26 |

| 29 |




Question 3
3. How many students live in a specific district and attend school in another
district?
e What districts are they attending?
e What is the trend over the years?

For question 3 the ResidentiISDName will remain in the Page area and the
SumofStudentCount in the Data area.

1. Dragging the OperatingDistrictName into the Row area and the
ResidentLEAName into the Column area provides these results:

ResidentlSDMName |I1-"Iacomh 1SD F]

|t_u|\_1_.

[ T Y TRr P — | 7= =TT O =\ FT -
41| OperatingDistrictName h nchur Bay School District | Armada Area Schools  Center Line Public Schoaols | Chippewa

@} Academic and Career Education Academy
Academy for Business and Technology

d )| Academy of Lathrup Village

A} Academy of Michigan

108 Academy of Oak Park 2

108 Academy of Warren 4

1M Advanced Technology Academy

1Bl AGBU Alex-Marie Mangogian School

108 Algonac Community School District 102

1B Almont Community Schools 2 10

ik

1

1

1

2
28| Benjamin Carson Academy

28| Berkley School District

28| Birmingham City Schoal District

2§ Blanche Kelso Bruce Academy

28| Bloomiield Hills School District

2M|Blue Water Learning Academy 2
3P| Bradford Academy

3§)|Eridge Academy

38| Brown City Community Schools

38| Business Entrapreneurship. Science. Tech.

Pivot Table Guide
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The list (in the example above) of OperatingDistrictNames is rather lengthy.
One option is to view only the LEA OperatingDistrictTypes. This can be
accomplished by dragging OperatingDistrictType into the Page area and
selecting Local Education Agency from the list:

- Bl -]
21 = &

A B
sidentlSDName Macomb 15D -
veratingDRistrictType All -

= al
m Of StudentCount Intermediate Schoal Dist. Eductnl.

weratingDistrictMarme F ocal Education Agency (District)
ademic and Career Education Academy Public Schaal Acaem}- {District)

ademy for Business and Technology
ademy of Lathrup Village

ademy of Michigan

ademy of Oak Park

ademy of Warren

vanced Technology Academy

3BU Alex-Marie Manoogian School
jonac Community School District 02
mnont Community Schools 2
chor Bay School District
n Arbor Leaming Community < ¥
nada Area Schools [ Select multiple items

5 Academy in the Woods [

ondale Schoal District

ttle Creek Area Learning Center [ _l
ttle Creek Public Schools

n Ross Public Schoaol Academy

Armada ¢

OK ] [ Cancel ] 16

The list of OperatingDistrictNames will now be limited to LEAS.

A B C ] i] | E

1 |ResidentlSDMame Macomb ISD - | !

2 |OperatingDistrictType Local Education Agency (Distrid =

3

4 esidentLEAName m

peratingUistrictiName ~ |Bhchor Bay Schoal District Armada Area Schools  Center Line Public Schools | Chippewa Valley Schools |C

Algonac Community School District 102
Almont Community Schools 2 10 1
Anchor Bay School District 1 1 43
Armada Area Schools 12 1
Avondale School District 1
Battle Creek Public Schools
Berkley School District 1
Birmingham City School District 2
Bloomfield Hills School District 3
Brown City Comrmunity Schools
Capac Community Schoal District 10 2

Camney-Madeau Public Schools
Carsonville-Port Sanilac Schoal District
Center Line Public Schools [
Chippewa Valley Schools 17 7 i

City of Harper Woods Schools
Clarenceville School District
Clarkston Community School District 2

Clawson Public Schools 1 6
Clintondale Community Schools 113 3 102 456
Dansville Schools

Dearborn City School District
Delton-Kellegg School District
Detroit City School District 14 32

Mt Cammmnimitne @ebnnl Dickeet




To focus on just one district, the OperatingDistrictType can be removed from
the Page area and the ResidentLEAName moved to the Page area. Then the

District of interest can be selected.
| A [ B [ C

den I Y =TT~ aroroh 0 [+ ]
|| ResidentL EAName Chippewa Valley Schools ﬂl

1
2
| 3]
4 |Sum Of StudentCount [
5 |OperatingDistricthame [=]Total
| 6 |AGBU Alex-Marie Manoogian School
| 7]
8
9|
0

ra
[=5]

Almant Community Schools
Anchor Bay School District
Armada Area Schools
| 10 |Arts Academy in the VWoods
| 11 |Avondale School District
| 12 |Berkley Schoal District
| 13 |Birmingham City Schaal District
| 14 |Blanche Kelso Bruce Academy
| 15 |Bloomfield Hills Schoal District
| 16 |Blue Water Learning Academy
| 17 |Capac Community School District
| 18 |Center Line Public Schoals
| 19 |Central Academy
| 20 |Clawsaon Public Schools
| 21 |Clintondale Community Schools
| 22 |Conner Creek Academy
| 23 |Conner Creek Academy East
| 24 |Covenant House Life Skills Center East
| 25 |Detrait City School District
| 26 |East China School District
| 27 |East Detrait Public Schoals
| 28 |Edison-Oakland Public School Academy
| 29 |[Ferndale Public Schools
| 30 |Fitzgerald Public Schoals
31 [Fraser Public Schools

32 |Great Oaks Academy
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=
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To view the trends over years, the Collections field can be moved to the
Column area.

A B c [ b [ E [T F T 6 T H ]
Resident/SDMName Macol~|ISD
ResidentLEAName Chipp| > b Valley Schools

Sum Of StudentCount Colleq ~

OperatingDistrictMame Fall2002 Fall2003 |Fall2004 Fall2005 [Fall2006 |Fall2007 [Grand Total §

AGBU Alex-Marie Manoogian School s S

Alment Community Schools

Anchor Bay Schoaol District

Armada Area Schools

Arts Academy in the Woods

| 11 |Avondale Schaool District

| 12 |Berkley School District 1

| 13 |Birmingham City School District 1 1

| 14 |Blanche Kelso Bruce Academy

| 15 |Bloomfield Hills Schoal District 1 1

| 16 |Blue Water Learning Academy 1

| 17 |Capac Community School District 1

| 18 |Center Ling Public Schools

| 19 |Central Academy

| 20 |Clawson Public Schools

| 21 |Clintondale Community Schaols

| 22 |Conner Creek Academy

| 23 |Conner Creek Academy East

| 24 |Covenant House Life Skills Center East

| 25 |Detroit City School District 7

| 26 |East China School District

| 27 |East Detrait Public Schools 5 8

| 28 |Edison-Oakland Public School Academy 1

| 24 |[Femdale Public Schools

| 30 |Fitzgerald Public Schools

| 31 |Fraser Public Schools 37 37 54

| 32 |Great Qaks Academy 1

| 33 |Hazel Park City School District
Huron Academy 34 43 41
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Question 4

4. How many non-resident students attend school in a specific district?
¢ Where are they from?
* What grade are they in?
¢ What schools are they attending?
* What is the trend over the years?

For question 4 leave the SumofStudentCount in the Data area.

1. Drag OperatingDistrictName to the Page area and choose the District of
interest.
| A | B | ¢ |

DperatingDistictiiame [Center Line Public Schools -

Sum Of StudentCount Total
Total J 952

—
L ]

This data displays the number of students over 5 years (fall of 2002 through
2007) who attended school in the OperatingDistrict listed but were not
residents of that district.

2. To see the trend over time of students coming from other districts, drag the
Collection field to the Column area.

A | B [ ¢ | ol E 1 F | & | H |
1
2 |OperatingDistrictMame [Center Line Public [+ hools
3 I
4 |Sum Of StudentCount JiCallection [~]
5 Fall2002
6 [Total
| 7 |
| G |
9
BT




To see the trend over time for students coming from other districts to all districts
in a particular ISD, drag the OperatingDistrictName to the Row area. Drag the
OperatinglSDName to the page area and select the OperatingISD of interest.

| u | e | | b | H |

2

3
K [-]

A | OperatingDistrictName Fall2003 Fall2004 |Fall2005 Fall2006 |Fall2007 |Grand Total
| @8 Acadenmy of Warren 430 657 657 1744
| W} Anchar Bay School District 207 193 282 285 299 3 15857
| BN Armada Area Schools 222 248 242 279 283 296 1570
| Bl Arts Academy in the Woods 163 262 297 348 377 349 1796

18} Ben Ross Public School Academy 477 509 952 633 2921

188 Center Line Public Schools 26 59 95 172 203 397 952

188 Chippewa Valley Schools 92 133 154 168 201 353 1101

1§} Clintondale Community Schools 1373 1460 1827 1658 2110 2125 10553

188 Conner Creek Academy 673 578 881 642 872 766 4412

188 Conner Creek Academy East 634 636 775 826 873 849 4643

1§ East Detroit Public Schools 208 148 245 163 136 227 1127

1§} Eaton Academy 260 269 705 256 476 432 2448

1§ Fitzgerald Public Schools I 105 238 29 327 468 1506
| 1§} Fraser Public Schools 382 512 637 675 828 859 3893
| 20 Great Qaks Academy 164 296 505 623 1586
| 2§ Huron Academy 446 487 479 455 485 408 2763
| 280 Lake Shore Public Schools (Macomb) 57T 636 a61 582 698 728 3782
| 2§ Lakeview Public Schools (Macomb) 697 841 892 897 928 1044 5299
| 28]L'Anse Creuse Public Schools 516 548 350 591 T01 1004 37480
| 28 Macomb Academy 76 95 101 109 114 120 615
| 2§ Macomb ISD 1652 1651 1759 1737 1797 1857 10453
| 28 Merritt Academy 174 201 398 426 513 813 2222

28t Clemens Community School District 429 472 472 465 412 416 2666
E[IML Clemens Montessori Academy 154 217 245 261 275 1152
| 3§ Mew Haven Community Schools 3 4 12 17 2 39 96
| 3} Prevail Academy 175 438 591 586 1802
| 38FRichmand Community Schools 21 11 12 15 28 60 147
| 3§ Romeo Community Schools 39 39 50 75 50 40 293
| 3§ Roseville Community Schools 342 718 803 806 673 622 3964
| 3§ South Lake Schools 206 251 282 338 349 653 2079
| 3 Utica Community Schools 26 110 182 325 480 1310 2433
| 3§} Van Dyke Public Schools 227 232 221 179 187 156 1202
= = = = R P v P P P mn -

To see what grades students are in who come from other districts, replace the
Collection field with the StudentGradeorSetting field (in the Column area).

A [ B [CIDIEIFIGIATI I [J [ K[LIM[N][O[PIA[RIS] T ]

1

2 |QperatinglSDName [Macomif~]D

3

4 |Sum Of StudentCount

5 |OperatingDistrictName
| 6 |Academy of Warren
| 7 |Anchor Bay School District 76 B0 90 98 97 1000 1000 99 95 123 155 125 132 163 1 23 1857
| 8 |Armada Area Schools 125 93| 85 77 79| 74| 76 73 68| 233 206 198 176 2 1570,
| 9 |Arts Academy in the Woods 600 571 390 235 1796
| 10 |Ben Ross Public School Academy 363 360| 320 293 269 259 329 412 316 2921
| 11 |Center Line Public Schools 6 185 99| 59 41 32| 25 22/ 15 15| 25 38 172 203 45 952
| 12 |Chippewa Valley Schools 143 147 124 119 97| 92| 80 54 51 43 39 32 62 16 2 1101
| 13 |Clintondale Comrmunity Schools 92 87| 95 100 111 M7 127 161 188 242 417 718 776 5078 23 2196 25 10553
| 14 |Conner Creek Academy 371 363 388 362 4000 401 422) 424 400 381 265 145 70 4412
| 15 |Conner Creek Academy East 437 425 422 425 423 415 4200 403 381 347 254 185 106 4643
| 16 |East Detroit Public Schools 22100 14 5 7 6 I 5 145 156 147 165 174 11 240 1127
| 17 |Eaton Acadenmy 190 181 125 128 115 129 24 487 421 353 295 2448
| 18 |Fitzgerald Public Schools 4 M 50N 3 8 17 16| 21 26) 253 307| 420 368 12 19 1506
| 19 |Fraser Public Schools 408 392 382 342 360 3100 307 280 223 232 194 142 131 5 180 3893
| 20 |Great Oaks Academy 226 212| 195 235 209| 187 154 113 &7 1588
| 21 |Huron Academy 418 409 432 366 319 296 259 145 102| 16 2763
| 22 |Lake Shore Public Schools (Macomb) 174 152] 1500 149 143| 136 167 171 166 269 290 465 523 395 112 291 24 3782
| 23 |Lakeview Public Schools (Macomb) 236 444 463 452 460| 466 535 513 527 259 263 360 313 3 5299
| 24 |L'Anse Creuse Public Schools 181 1400 117 1200 110 100) 99 101 72| 109 152 545 674 699 1 481 49 3750
| 25 |Macomb Academy 495 120 615
| 26 |Macomb ISD 86 96| 136 166 185 214 241 290 297 339 330 276 199 6328 1268 10453
| 2T |Merritt Academy 274308 301 278 245 239 182 180 129 55 21 2222
| 26 |Mt. Clemens Community School District 483 309 253 224 213 185 116 &9 107 218 168 147 141 13 2666
| 28 |Mt Clemens Mantessori Academy 345 264| 207 156 114 66 1152
| 30 |New Haven Community Schools 10 4 4 1 3 3 2 4 10 9] 18 24 2 2 96
| 31 |Prevail Academy 269 289 259 228) 221| 206/ 176 112] &2 1802
| 32 |Richmond Community Schools 10 6 4 8 4 9 5 Tl 200 27 18 26 3 147
| 33 |Romeo Community Schools 25 13 12 12 8 8 4 s 6 7 17| 19 63 82 3 6 293

34 |Roseville Community Schools 224 234| 246 249) 265 254| 271| 313 334 337 374| 394 437 AN 1 3964
| 35 |South Lake Schools 5 132 164) 152 160 162| 159 124) 119 116 151 124) 292 218 1 2079

36 |Utica Community Schools 252 256 229 214) 224| 168 187 212 232| 189 117 65 53 15 20 2433
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5. To find out what residential districts students are from, drag the
OperatingDistrictName to the page area and the ResidentLEAName to the

Row area.
N
| —ETEE ]
T ——
4 d
5 - Wictal
6 JfAlgenac Community School District 1
7 JAImont Community Schools 10
5 J#Anchor Bay School District 26
9 14
10 4
11)|Berkley School District 1
12)Birmingham City School District 1
13]\Bloomfield Hills School District 1
14)}zenter Line Public Schools 21
15{iChippewa Valley Schools 413
16\Clintondale Community Schools 183
17)Detroit City School District 14
18]\East Detroit Public Schools 73
19)lFitzgerald Public Schools 138
20)Fraser Public Schools 54
21|}Grosse Pointe Public Schools 4

22

Hazel Park City School District

—

6. To find out what school the non-resident students are attending within the district,
replace the ResidentLEAName with OperatingBuildingName to see the

results.
I
2 |OperatingDistrictMame [Chippewa Valley Schools m
3
4
51 OperatingBuildingMame ~|[Tatal
Gl Algonguin Middle Schaool a4
7}l Cherokee Elementary Schoaol 73
8}l Cheyenne Elementary School 50
91 Chippewa Valley Adult and Mohegan Alt. Educ. 16
10§ Chippewa Valley High Schoal 90
14) Clinten Valley Elementary School 197
14) Dakota High School 86
13} Erie Elementary School 92
14§ Fox Elementary School 19
18§ Huran Elementary School 53
18§ Iroquois Middle School 36
14§ Miami Elementary School 28
18 Mohawk Elementary School 19
190 Ojibwa Elementary School 23
200 Ottawa Elementary School a7
21| Seneca Middle Schoal 26
231 Sequaoyah Elementary School 3
231 Shawnee Elementary School 45
240 \Wyandot Middle Schoal 39
281 Grand Tatal 1101
26
27




Chapter 4 - Creating Charts

Creating Charts

It is easy to create charts from the Pivot Table results. Simply click the Chart button on
the Pivot Table Toolbar when the results are displayed that you would like to chart.

PivotTable = | j'l

If this is the Pivot Table being displayed:

1

2 |OperatingDistrictName |Chippewa Valley Schools m

3

4 |Sum Of StudentCaount

5 |OperatingBuildingMame v |Tatal
| 6 |Alganquin Middle School 84
| 7 |Cherokee Elementary School 73
| 8 |Cheyenne Elementary School a0
| 9 |Chippewa Valley Adult and Mohegan Alt. Educ. 16
| 10 |Chippewa Valley High School 90
| 11 |Clinton Valley Elementary School 197
| 12 |Dakota High School 86
| 13 |Erie Elementary School 92
| 14 |Fox Elementary School 19
| 15 [Huron Elementary Schaool 53
| 16 |Iroquais Middle School 36
| 17 [Miami Elementary School 58
| 18 |Mohawk Elementary School 19
| 19 |Qjibwa Elementary School 23
| 20 |Ottawa Elementary School 87
| 21 |Seneca Middle School 26
| 22 |Sequoyah Elementary Schoal 3
| 23 |Shawnee Elementary School 45
24 |Wyandot Middle Schoal 39
25 |Grand Tatal 1101
| 26 |

27

When the Chart Button is clicked this will be the Chart created:

Total

Sum Of StudentCount]

250

200 —

150

100

a0

Dakota High School
Iroguois Middle School

Erie Elementary School
Fox Elementary School [T
Seneca Middle School [10]

WMohegan Alt. Educ
Ojibwa Elementary School [1]

Algonquin Middle School

=
=)
[
Chippewa Valley High School
1
.

Cherokee Elementary School
Huron Elementary School

Cheyenne Elementary School
Chippewa Valley Adult and
WMiami Elementary School
Mohawk Elementary School []
Ottawa Elementary School
Sequoyah Elementary School []
Shawnee Elementary Schaol
Wyandot Middle School [T

lintan Valley Elementary School
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Modifying Charts
The information contained in the chart can be modified in a number of ways.

1. The drop down list (from the Page area of the Pivot Table) can be used to
change the selection (The OperatingDistrictName in this instance).

[
|operatingDistrictiame] Chippewa valley Schaols (-1

Cassapalis PublC Schodls 2
Cedar Springs Public Schools 0
Center Academy

Center for Literacy and Crestvity
Center for Literacy and Creativity *
Sum Qf StudentCount]
250 Central Academy

Central Lake Public Schools
Central Montcalm Public Schools
Centreville Public Schools

200 —

150 i

Schaols
100 L [ =
[ select multiple items

A & TelnNanla.

2. This will display information related to the chosen selection.

Sum O StudertCount)
s00
450
100 +—
350 =t
300 J=—q
250 =—
|mTana |
200 =—
50 +—1
100 +—f
) ==t
o
Center Ling Crofhers Earty Mark C Hoose MayV Peck Muller Waolte Middle
High Schopl  Elementary Chiahoog Elementary  Elementary  Elementary School
School Center School School School

3. Fields can also be dragged onto the Legend (at the right) to add more
information to the chart. This is an example of dragging the
StudentGradeorSetting to the chart.

500

{StudenmGradeOrseting,
CED
| |mz
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| |ooe
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mi’

| |o0E
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mod egend
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o02
| [oot
moo

= = -

- = o B

—

center Ling Crothers Earty Mark C. Roose  May V. Peck Miller Wolle Miadie
High School Elementary Childhood Elementary Elementary Elementary Schoal
Schoal Center School School Schoal




Embedding Chart on Worksheet

It is possible to embed a chart on the same worksheet as the pivot table by following the
steps below:

1. Click outside the pivot table.

2. Click the Excel Chart Wizard on the standard toolbar. | i

3. Choose the pie chart in the first step of the wizard:

Chart Wizard - Step 1 of 4 - Chart Type

Standard Types | Custom Types

Chart type: Chart sub-type:
i Column e
= s
|ﬁ Line
@ —
| XY {Scatter) O D
s 9=
-] Doughnut L4 '
iy Radar
@ Surface
8s Bubble ~
Pie. Displays the contribution of each value
0 a total,

[ Press and Hold to View Sample ]

4. Add a Title in the 3" step of the wizard. Click Finish.
Chart Wizard - Step 3 of 4 - Chart Options

Titles |Legend Data Labels

Chart title:
sident Students by Building| |

[OperatingDistricthame] Clintndale Community Schosls [«

Non-Resident Students by Building

| | DperatingBuildingl] = |

Fum OF StudentCo O Charles . MeGlinne
Echool

| Clintendal: High
Echaal

O Clintendals Middle
Zchool

O Fainbow Elementary
School

B Robbic Hall Parker
Echool

[ Cancel ][ < Back ” Mext = l[ Einish
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5. The chart will be displayed on the same page as the pivot table.

1
2 |OperatingDistrictName [Clintondale Community Schaol{~]
3
4 |Sum Of StudentCount
5 |OperatingBuildingMame ~|Total
| 6 |Charles G McGlinnen School 161
| 7 |Clintendale High Schoal a70
| 8 |Clintondale Middle School 482
| 9 |Rainbow Elementary Schaol 181
10 |Robbie Hall Parker Schoal 332
11 [Grand Total 2096
2]
13 — - -
By Operatnglstnctl\Jame|Cllntondale Community Schoo\s[zl
15 . -
16| Non-Resident Students by Building
E OperatingBuildingName
] e e
(19| Sum Of Studentd m Charles C. McGlinnen
20 School
[21] | Clintondale High School
[22]
| 23 | O Clintondale Middle
| 24 | School
125 ORainbow Elementary
|26 School
271 m Robbie Hall Parker
| 28| School
[29]
30

Creating Standard Excel Charts from Pivot Tables

It is possible to create a traditional Excel chart from pivot table information, one that
does not display the pivot table features as part of the chart. The way to accomplish
this is to paste the values from the pivot table to a new worksheet.

Copy & Paste Pivot Table Data
1. Right-click anywhere in the pivot table. Choose Select->Entire Table.

Sum Of StudentCount
OperatingBuildinghame - |[Total

Charles C. McGlinnen Schoal 161

Clintondale High School | 970
Clintondale L 482
Rainbow EIf 23| Format Cells... 151
| |Robhie Hall ]| Pivorchart 332
Grand Total _ 2096

i [el| PivotTable wizard

] [}

—||Operatin{ * BH=naa mmunity Schools f

i i tudents by Building

B Select 3 pting

1l Group and Show Detall » pries

U Ordgr 3 i 00l
tan:

) og Field Settings... ‘ Entire Table

: Table Optians... Enable Selection  itom

o Hide PivotTable Toolbar Sthool

q Hide Field List ORainbor

L School

B mRaobbie

i Drap Series Fislds Hers| School

2. Choose Edit->Copy from the menu.

icrosoft Excel - Pivot Tables.xls
File | Edit | View Insert Format Tool

= B2 comy ctrl+c
.f@g Office Clipboard...

[TE

B3 % paste Ctrl+y

Paste Special...




Select a new worksheet and click in the cell where you want the top left corner of
the table.

Choose Edit>Paste Special...

[l Microsoft Excel - Pivot Tables.xls

g_] File | Edit | Wiew Insert Format Tools Data

B Lj ‘M Can'tUndo Cirl+Z ?Iiil ¥ B3
53 Copy Cirl+C - 10«
A3 | &k office Clipboard. .. r

Al pese  cov [ D T
1 -
— Paste Special...
a1 | |
3 Fill 3
4_ Clear 3
5_ Delet
6 Delete...

Choose Values and click OK.

Paste Special

Paste

O all () validation

() Eormulas () all except borders

@ ) Column widths

() Formats ) Formulas and number formats

) Comments {3 Values and number formats
Operation

{(*) MNone O Multiply

O Add ) Divide

) Subtract

[ skip blanks [ Transposs

[ Ok l l Cancel ]

The labels and data from your pivot table will be displayed on the new worksheet.
You may need to widen columns and add some formatting.

1]

2 |

3 |OperatingDistrictName Clintondale Community Schools
4

i Sum Of StudentCount

6 |OperatingBuildingMame Tatal

7 _|Charles C. McGlinnen School 161
8 |Clintondale High Schoal 970
9 |Clintendale Middle School 452
10 |Rainkow Elementary School 151
11 |Robbie Hall Parker School 332
|12 | Grand Total 2096
13 |

14 |

15 |

Once the new worksheet is created with data from the pivot table, it will be
possible to create an Excel chart using the traditional charting tools.
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7. Select the information from the new worksheet and click the Excel Chart Wizard
button. | il

| Make sure you don't include the totals with your selection.

1]
2]
| 3 |OperatingDistrictName Clintondale Community Schools
4
ZSum Of StudentCount
6 |OperatingBuildingName Total
| T [Charles C McGlinnen Schoal 161
| 8 [Clintandale High School 970
| 9 [Clintondale Middle School 482
| 10 [Rainbow Elemantary School 181
11 [Robbie Hall Parker School 3321
| 12 [Grand Total 2096
3]
14

8. Choose the pie chart in the first screen of the wizard then click the Next button
twice.

9. Add a chart title in the third step of the wizard. Click Finish.

Chart Wizard - Step 3 of 4 - Chart Options

Titles |Legend Data Labels
Chart title:

Non-Re',;ident Students by Bui Non-Resident Students by Building

B Charles C. MeGlinne
Sehasl

| Clintandsls High
Sch

Sch
B Robbia Hall Farker
chaol

[ Cancel ][ < Back “ [ext = ][ Einish

10.A traditional pie chart will be embedded on the page with the worksheet.

JperatingDistrictlame Clintondale Community Schools

Sum Of StudentCount

JperatingBuildingMarme Total

Zharles C. McGlinnen School 161

Slintondale High School 970 Non-Resident Students by Building

Slintandale Middle School 482

Qainkow Elementary School 151

Qobhie Hall Parker School 33z

Srand Total 2096 m Charles C. McGlinnen

School
B Clintendale High School

O Clintondale Middle
School

O Rainbow Elementary
School

W Robbie Hall Parker
School




Chapter 5 - Customizing Pivot Tables

Sorting Pivot Table Data

By default, items in the pivot table are sorted in ascending order. To change the order,
click in the column of items and click the descending button on the toolbar. AL

Another option is to drag the items in the list to create a new sort order. The associated
number will move with the item.

Show & Hide Options

There may be times when it is important to take an item out of the list. For example, in
the list below, students coming from other districts to attend adult education classes are
displayed and included in the total:

1
B OperatingDistrictName Chippewa Valley Schools :
3
| 4 |Sum Of StudentCount
5 _|OperatingBuildinghame ~ |Total
| 6 |Algenguin Middle School 84
| 7 |Cherokee Elementary Schoel 73
= a0
va Valley Adult and Mohegan Alt. Educ 16
. T — 90
11 [Clinton Valley Elementary School 197
12 |Dakota High School 36
nnnnnnnnnnnnnnnnnnnnnnnnn a9

To limit the listing to just the elementary, middle and high schools:

1. Click the list arrow to the right of OperatingBuildingName.

2. Locate the building to remove from the list and click to remove the checkmark.
Click OK.

3. The item will be removed and the total will adjust to reflect the new list.

'
'LOperatmgD\slrlclName Chippewa Valley Schools [~
3
| 4 [Sum Of StudentCount
| 5 |OperatingBuildingName > |Total
| 6 |Algonguin Middle School 84
7 _|Cherokee Elementary School 73
| 8 |Cheyenne Elementary School 50
| 9 |Chippewa Vallsy High School 90
| 10 [Clinten Valley Elementary School 197
| 11 |Dakota High School 86
| 12 [Erie Elementary School 92
13 |Fox Elementary Schoaol 19
| 14 [Huron Elementary Schoal a3
| 15 |Iroquois Middle School 36
| 16 [Miami Elementary School 58
| 17 |Mohawk Elementary School 19
| 18 |Ojibwa Elementary School 23
19 |Ottawa Elementary School a7
| 20 [Seneca Middle School 26
| 21 |Sequoyah Elementary School 8
| 22 |Shawnee Elementary School 45
23 |Wyandot Middle School 39
24 |Grand Total 1085
| 25|

Pivot Table Guide

S




Pivot Table Guide

~

Customizing Field Names

The field names in the pivot table inherit the names used in the source document.
However, it is possible to change them. For example, to change
OperatingBuildingName in the table below to School Building:

1
2o eratingDistrictName |Chippewa Valley Schools m

3

1 —= EE—————

5 [DoeratingBuidinglame [

5 rem. PR
ZCherokee Elementary School 73
| 8 [Cheyenne Elementary School a0
| 9 |Chippewa Valley High School 90
| 10 |Clinton Valley Elementary School 197
| 11 |Dakota High School 86
| 12 |Erie Elementary School 92
| 13 |Fox Elementary School 19
| 14 |Huron Elementary School 53
| 15 |Iroquois Middle School 36
| 16 [Miami Elementary School 53
| 17 [Mohawk Elementary School 19
| 18 | Ojibwa Elementary Schoaol 23
| 19 | Ottawa Elementary School a7
| 20 [Seneca Middle School 26
| 21 |Sequoyah Elementary Schoal i
| 22 | Shawnee Elementary School 45

23 |Wyandot Middle School 39

24 | Grand Tatal 1085

25

e

1. Double-click the heading (OperatingBuildingName) in the pivot table.

2. Type in the preferred name in the PivotTable Field box and click OK.
PivotTable Field

Mame: | School Building | oK
Subtotals

@ Automatic

O tone

X

3. The new name will be displayed in place of the previous one.

1

2 |OperatingDistrictName |Ch\EEewa Walley Schools m
3

_7_|Cherckee Elementary School 73]
8 |Cheyenne Elementary School 50|
9 |Chippewa Valley High School 90|
10 |Clinton Valley Elementary School 197
11 |Dakota High School 86
12 |Erie Elementary Scheol 92
13 |Fox Elementary School 19
14 |Huren Elementary School 53
15 |Irequois Middle School 36
16 |Miami Elementary School 25
A7 |Mohawk Elementary School 19
18 |Ojibwa Elementary School 23]
19 |Ottawa Elementary School 87
20 |Seneca Middle School 26
21 |Sequoyah Elementary School il
22 |Shawnee Elementary School 45
23 |Wyandot Middle School 39
24 |Grand Total 1085
25

26




Copying & Pasting Pivot Tables

The Pivot Table can be copied and pasted to a new location. This will be especially
helpful if you want to create and save several different variations of the pivot table. To
copy a pivot table and maintain the pivot table look and functionality follow the steps

below:

1. Right-click anywhere in the pivot table. Choose Select>Entire Table.

_|Sum Of Stu

QOperatingBuildingMame -

dentCount

Total

Charles C. McGlinnen School

161

icrosoft Excel - Pivot Tables.xls

File

B3

F18

Edit | View [Insert Format Tool:

Copy

cri+c |

[Fe

Office Clipboard...

Paste

Paste Special...

the table.

Cirl+v

In:

:Chmomda\e High School 970
_|Clintandale 482
_|Rainbow EIf ##| Format Cels... 151
|| Robbie Hall ] Pvotchart 332
Grand Tota - 2096
i (3] PivatTable wizard
“-||Operatin ¥ Refiesh Daia mmunity Schools f
i
il ide D tudents by Building
4 Seect = hting
Tl Group and Show Detal priec
[ Order 3 and Da ool
itont
H @y Field settings. . [ EnweTabe
il Table Options... Enable Selection  [ton:
| Hide PivotTable Toolbar School
B Hide Field List ORainbor
LI School
i W Robhie
4 School

Choose Edit=>Copy from the menu.

Select a new worksheet and click in the cell where you want the top left corner of

Choose Edit->Paste to add the pivot table to the new worksheet.

To paste the information from the pivot table without the pivot table
functionality, follow steps 1-3 above. In step 4 choose Edit ?Paste
Special... and select Values from the dialog box.

Pivot Table Guide
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Chapter 6 - Formatting Pivot Tables

Autoformatting a Pivot Table

To enhance the look of the pivot table, there is an AutoFormat tool that is quick and
easy to use.

1. Click inside the pivot table.

2. Choose the Format Report button on the PivotTable toolbar.

4. If the results are not great, click the Undo button and try again.
__Or__
Apply formatting in the same way as you would with a traditional spreadsheet.

Applying Number Format

To change the formatting of the numbers in the worksheet, select the numbers then
apply number formatting in the same manner as standard worksheet.

1. Select the numbers.

€0 .00 |
T I e B

|
2. Click a number format button on the format toolbar
__Or__
Choose Format->Cells and select a number format option using the Number
tab.




